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Trang 1 

 

(MS WINDOWS 7-WINDOWS 10, MS OFFICE 2013 TRỞ LÊN) 

 

CÂU HỎI LÝ THUYẾT PHẦN KIẾN THỨC CƠ BẢN MÁY TÍNH 

 

1. Phát biểu nào sau đây về RAM là đúng 

A. RAM có thể đọc và ghi dữ liệu   

B. RAM có dung lượng lớn hơn đĩa cứng 

C. RAM có chức năng giống như ROM   

D. RAM chỉ cho phép đọc dữ liệu 

2. Chọn thứ tự tăng dần khi sắp xếp các đơn vị đo thông tin: 

A. KB, GB, MB, TB   B. MB, TB, GB, KB 

C. KB, MB, GB, TB     D. TB, GB, MB, KB 

3. Loại máy tính nào thường dùng để chạy phần mềm chuyên môn hoá (specialized) và được dành để 

chia sẻ tài nguyên, quản lý nguồn dữ liệu lớn? 

A Netbook  B.Desktop  C.Tablet  D.Server  

4. Phần mềm hệ thống là? 

A. Chương trình hoặc hệ thống chương trình giúp máy tính hoạt động hoặc hỗ trợ hoạt động của hệ 

thống máy tính            

B. Hệ điều hành          

C. MS Office                  

D.Phần mềm cung cấp giao diện. 

5. Ý nghĩa của ký hiệu Hz là gì? 

A. Tốc độ sung nhịp bên trong của máy tính trong mỗi chu kỳ 

B. Tốc độ kết nối Internet  

C. Đơn vị đo dung lượng dữ liệu trên máy tính 

D. Tốc độ quay của quạt chip CPU. 

 

TRẮC NGHIỆM PHẦN MẠNG & INTERNET 

 

6. Việc tải file dữ liệu từ internet bị chậm là do: 

A. File có dung lượng lớn  

B. Đường truyền internet tốc độ thấp. 

C. Server cung cấp dịch vụ internet bị quá tải 

D. Tất cả đều đúng 

7. Phát biểu nào dưới đây về trang web tĩnh là chính xác nhất? 

A. Là trang web chỉ chứa nội dung văn bản 

B. Là trang web không chứa hình ảnh động như đoạn phim video 

C. Là trang web không có khả năng tương tác với người dùng 

D. Là trang web không cung cấp chức năng tìm kiếm 

8.Chức năng Bookmark của trình duyệt web dùng để: 

A. Lưu trang web về máy tính 

B. Đánh dấu trang web trên trình duyệt 

C. Đặt làm trang chủ 

D. Tất cả đều đúng 

9. Để chuyển tiếp thư, dùng nút 

 A.Reply   B.Reply to All  C.Forward D. Attachment 

10. Để truy cập vào một WebSite ta phải biết: 

A. WebSite đó được đặt tại đâu  

B. Tên miền của WebSite đó 

C. IP của của máy chủ chứa WebSite đó  
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D. Tất cả Sai 

 

11. Để mở một tab mới trên trình duyệt IE,Chrome…, ta sử dụng tổ hợp phím: 

A. Ctrl_T  B. Ctrl_Y  C. Ctrl_N  D. Ctrl_S 

12. ISP là gì? 

A. Là nhà cung cấp dịch vụ Internet. 

B. Là nhà cung cấp cổng truy cập Internet cho các mạng. 

C. Là nhà cung cấp thông tin trên Internet. 

D. Tất cả đều đúng. 

13. Phần mềm nào sau đây không phải trình duyệt WEB? 

A. Microsoft Internet Explorer 

B. Mozilla Firefox 

C. Chrome 

D. Google Drive 

14. Địa chỉ nào sau đây là địa chỉ web không hợp lệ?  

A. www.tayninh.edu.vn 

B. http://ttgdtxtayninh.edu.vn 

C. https://phongnnth.ttgdtxtayninh.edu.vn 

D. www.phongnnth@ttgdtxtayninh.edu.vn 

15.  Một máy tính cung cấp tài nguyên hoặc tạo ra các dịch vụ cho máy khác gọi là: 

 A. Supercomputer – siêu máy tính 

 B. Client – máy khách  

 C. Server – máy chủ   

 D. Workstation – máy trạm 

16. Mục đích chính của việc thiết lập một mạng máy tính là: 

 A. Để truy cập vào bất kỳ thiết bị máy tính nào trên mạng 

B. Để cho phép hai hay nhiều máy tính trên mạng có thể giao tiếp với nhau , chia sẻ tài nguyên hoặc 

trao đổi dữ liệu 

C. Để tạo danh sách liên hệ cho các cá nhân và doanh nghiệp trên mạng 

D. Để dễ dàng truy cập Internet 

17. Chương trình nào sau đây của Windows để duyệt web? 

    A. Microsoft Edge        B. Microsoft Egg 

    C. MS Dotnet         D. MS.NET 

18. Muốn tìm thông tin về những tập tin DLL chỉ có trên website Microsoft.com, tiêu chí tìm kiếm được 

sử dụng là: 

A. DLL files site: microsoft.com 

B. DLL files link: microsoft 

C. DLL files host: microsoft 

D. DLL files AND microsoft.com 

19. Thiết bị mạng LAN nào giúp xác định điểm đến, điểm đi cho mỗi mạng : 

A. Hub          B. Switch 

C. Router         D. Bridge 
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TRẮC NGHIỆM WINDOWS 

 

20. Muốn thay đổi dạng số, kiểu hiển thị ngày tháng trong Windows ta vào Control Panel (hiển thị dạng 

Large Icon) tìm và thực thi từ Icon liên quan đến: 

 A. Date/Time.  B. Region And Laguage.   C. Fonts.  D. System. 

21. Trong Windows, tập tin Shortcut là: 

 A. Một tập tin văn bản . 

 B. Một tập tin hệ thống. 

 C. Một tập tin khi thực thi sẽ mở một ứng dụng nào đó. 

 D. Một tập tin khi thực thi sẽ mở một thư mục hoặc file nào đó trên máy tính.   

22. Chương trình nào sau đây có thể dùng để giải nén tập tin, thư mục: 

 A. WinZip B. WinRAR 

 C. Câu A và B đều sai D. Câu A và B đều đúng.   

23. Muốn cài thêm font mới trong windows, ta thực hiện: 

 A. Vào Control Panel, tiếp tục tìm và thực thi các lệnh liên quan đến Fonts để thêm.   

 B. Vào Control Panel tìm và thực thi các lệnh liên quan đến Programs 

 C. Vào MS Word chọn menu Format\Font. 

 D. Các câu trên đều sai. 

24. Trong môi trường Windows ta có thể chạy cùng lúc: 

 A. Hai chương trình. B. Chạy nhiều trình ứng dụng khác nhau.   

 C. Chỉ chạy một chương trình. D. Câu A, B, C sai. 

25. Trong Windows ta có thể tìm kiếm tập tin: 

 A. Theo kích thước . B. Theo ngày tháng tạo lập. 

 C. Theo kiểu tập tin. D. Các câu trên đều đúng.   

26. Trong Windows, để xóa hẳn tập tin, thư mục (không bỏ vào Recycle Bin) ta dùng tổ hợp phím: 

 A. Ctrl – Delete.  B. Alt – Delete. 

 C. Shift – Delete.   D. Tab – Delete. 

27. Trong hệ điều hành Windows, công dụng của phím Print Screen là gì? 

A. In màn hình hiện hành ra máy in. 

B. Không có công dụng gì khi sử dụng 1 mình nó. 

C. In văn bản hiện hành ra máy in. 

D. Chụp ảnh màn hình hiện hành vào vùng nhớ clipboard. 

28. Trong Windows Explore để đổi tên thư mục, tập tin được chọn, ta thực hiện : 

 A. Click phải chuột\chọn Rename B. File\Rename 

 C. Nhấn F2 D. Câu A, B, C đúng.   

29. Trong Windows Explore hiển thị tập tin dạng chi tiết (có ngày, giờ, kiểu), ta thực hiện các lệnh/công 

cụ liên quan từ khoá: 

 A.List. B. Details.   

 C.Small Icons. D. Large Icons. 

30. Chọn phát biểu đúng. Hệ điều hành Windows là: 

A. Hệ điều hành đa nhiệm B. Hệ điều hành có giao diện đồ họa. 

C. Câu A, B đúng.   D. Câu A, B sai. 
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TRẮC NGHIỆM PHẦN MS WORD  

31. Trong Microsoft Word để chọn tất cả văn bản ta thực hiện: 

 A. Ctrl – A.                                 B. Ctrl – C. 

 C. Ctrl – V.                                 D. Ctrl – X. 

32. Trong MS Word để làm kí tự đặc biệt (Symbol) lớn lên thì: 

 A.Bấm chuột vào góc và kéo ra  B. Khối kí tự rồi chọn cỡ chữ (Size) lớn 

 C.Sử sụng chức năng DropCap  D.Câu B và C đúng 

33. Chọn nhóm phím dùng trong soạn thảo văn bản để di chuyển con trỏ 

 A. Home, End, PageUp, Page Down  B. Các phím F1  đến F12 

 C. Caps Lock, Num Lock, Scroll  Lock           D. Shift, Alt, Ctrl 

34. Để đưa con trỏ văn bản về cuối dòng hiện hành, ta thực hiện: 

 A. Ctrl + Home     B. Ctrl + End 

 C. Home      D. End. 

35. Trong MS Word, sử dụng phím F12 dùng để: 

 A. Đổi chữ thường thành chữ IN HOA.       B. Phóng to cửa sổ. 

 C. Lưu tài liệu đang soạn thảo với tên khác.            D. Không làm gì cả. 

36. Font đang chọn là Tahoma, ta phải chọn bộ mã nào để có thể gõ được Tiếng Việt 

 A. TCVN3                                    B.VNI WINDOW 

 C. UNICODE                                D.UTF-8 

37. Trong Microsoft Word để chuyển đổi chế độ ghi đè ta gõ phím: 

 A. Ctrl                               B. Alt 

 C. Delete                          D. Insert 

38. Trong soạn thảo MS Word, công dụng của tổ hợp phím Ctrl - H là : 

    A. Tạo tệp văn bản mới       B. Chức năng thay thế trong soạn thảo 

    C. Định dạng chữ hoa       D. Lưu tệp văn bản vào đĩa 

39. Trong Word công cụ Justify để căng ký tự (canh lề) theo: 

 A. Lề trái                                B. Lề phải 

 C. Canh giữa                              D. Đều hai biên 

40. Trong MS Word, tổ hợp phím Ctrl-] dùng để : 

 A. Giảm 1 cỡ chữ.                                 B. Tăng 1 cỡ chữ. 

 C. Tăng 2 cỡ chữ.                                 D. Giảm 2 cỡ chữ. 

41.Trong MS Word tổ hợp phím  Ctrl _Shift _=  dùng để định dạng : 

 A. Chỉ số dưới (hệ số).                         B. Chỉ số trên (số mũ). 

 C. Không làm gì cả                              D. Câu A, B C sai. 

42. Trong MS Word sau khi khối đoạn văn bản rồi nhấn Ctrl-X thì: 

 A.Xóa đoạn văn bản đó   B. Dời đoạn văn bản đó sang vị trí mới 

 C.Sao chép thêm đoạn văn bản mới  D.Xóa đoạn văn bản đó và lưu vào clipboad  

43.Trong MS Word để làm chữ rỗng ta dùng chức năng sau đây trong hộp thoại định dạng Font: 

 A. Shadow      B. Outline 

 C. Emboss     D. Engrave 

44.Trong MS Word, ta có thể thực hiện được: 

 A. Làm lớn ký tự đầu tiên của Paragraph.   B. Định dạng dòng văn bản. 

 C. Chèn hình ảnh từ tập tin trên đĩa USB.  D. Câu A, B, C đúng. 

45.Trong Microsoft Word để xuống dòng mà không ngắt Paragraph, ta thực hiện: 

 A. Nhấn tổ hợp phím Ctrl-Enter.    B. Nhấn tổ hợp phím Alt-Enter.   

 C. Nhấn tổ hợp phím Shift-Enter.    D. Câu A, B, C sai. 

46.Trong MS Word, chức năng Dropcap dùng để: 

 A. Tạo bảng biểu.                                      B. Đổi chữ thường thành chữ  HOA. 

 C. Làm lớn ký tự đầu đoạn văn bản.          D. Câu A, B, C sai. 

47. Trong MS Word để ngắt cột cho đoạn văn bản (có chia cột), ta sử dụng tổ hợp phím: 
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 A. Ctrl + Shift + Back                           B. Shift + Enter 

 C. Ctrl + Enter                      D. Ctrl + Shift + Enter  

48. MS Word, chức năng Split Cells dùng : 

 A. Tách một bảng biểu thành nhiều bảng.                 B. Tách một ô thành nhiều ô. 

 C. Câu A, B đúng.                                                 D. Câu A, B sai. 

49. Trong Word, muốn đánh số trang tự động , ta chọn : 

 A. FORMAT/Paragraph         B. FORMAT/Page number 

 C. INSERT/Page number      D. INSERT/Paragraph 

50. Trong MS Word, phát biểu nào sau đây đúng? 

A. Biểu đồ cột rất thích hợp để so sánh dữ liệu có trong nhiều cột 

B. Biểu đồ hình tròn rất thích hợp để mô tả tỉ lệ của giá trị dữ liệu so với tổng thể 

C. Biểu đồ đường gấp khúc dùng so sánh dữ liệu và dự đoán xu thế tăng hay giảm của dữ liệu 

D. Cả 3 câu đều đúng  

51. Trong Word, muốn thiết lập trang in theo chiều ngang, ta chọn : 

 A. Portrait                                   B. Landscape 

 C.Top                                         D. Bottom 

52. Trong MS Word để thêm một hàng nối đuôi vào bảng, ta định vị trỏ vào ô cuối cùng rồi gõ phím: 

 A. Insert                                       B.Alt 

 C.Ctlr - Tab                                D. Tab 
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CÂU HỎI EXCEL   
53. Trong bảng tính Excel, nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa là gì? 

    A. Chương trình bảng tính bị nhiễm virus 

    B. Công thức nhập sai và Excel thông báo lỗi 

    C. Hàng chứa ô đó có độ cao quá thấp nên không hiển thị hết chữ số 

    D. Cột chứa ô đó có độ rộng quá hẹp nên không hiển thị hết chữ số 

54. Trong excel, để biết được ngày hiện tại trong hệ thống máy tính (không cần hiển thị giờ, phút, giây., 

ta sử dụng hàm nào trong các hàm có tên dưới đây 

A. Date B. Now   

C. Today    D. Year 

55. Trong Excel, tại ô A2 có giá trị là chuỗi TINHOC. Tại ô B2 gõ công thức =RIGHT(A2,10) thì nhận 

được kết quả ? 

    A. 4               B. TINHOCNHOC                  C. TINHOC      D. 6 

 

56. Các tập tin bảng tính Excel có phần kiểu (phần mở rộng) là : 

A. EXE, EXEX  B. DOC,DOCX 

C. DAT,DATX D. XLS, XLSX  

57. Trong MS Excel chỉ có địa chỉ cột được thay đổi, còn địa chỉ dòng cố định khi ô chứa công thức được 

sao chép đến vị trí ô khác, thì gọi là địa chỉ gì? 

A. Địa chỉ tương đối. B. Địa chỉ tuyệt đối. 

C. Địa chỉ tương đối cột, tuyệt đối dòng.  D. Địa chỉ tuyệt đối cột, tương đối dòng. 

58. Trong MS Excel, khi nhấn phím Home có nghĩa là 

A. Chuyển về ô đầu tiên của bảng tính (ô A1).  B. Chuyển về ô cuối cùng của bảng tính 

C. Chuyển về ô đầu dòng.  D. Chuyển về ô cuối dòng. 

59. Trong Microsoft Excel chọn nhóm hàm chuỗi gồm: 

A. Left, Max, Min. B. Left, Right, Mid.   

C. Mid, Mod, Min. D. Value, Int, Round. 

60. Trong công thức của Excel, để nhập toán tử luỹ thừa (số mũ) ta dùng : 

A. Tổ hợp phím Ctrl_Shift_=. B. Tổ hợp phím Ctrl_=. 

C. Phím ^ . D. Không có toán tử này.  

61. Trong Excel, toán tử “%” là : 

A. Phép chia lấy số dư. B. Phép chia lấy phần nguyên. 

C. Phép toán “phần trăm”. D. Không có toán tử này. 

62. Trong Excel, cặp toán tử “<” “ >” liền kề nhau dạng “<>”là: 

A. Cho biết giá trị “nằm trong khoảng”. B. Toán tử so sánh “khác nhau”.  

C. Thay cho toán tử “=”. D. Không sử dụng được. 

 

63. Trong Excel. Biểu thức sau cho kết quả là gì  

= “abcde” - “cde” 

A. Báo lỗi   B. 2  

C.  3 D. “ab”  

64. Trong Excel. Biểu thức sau cho kết quả là bao nhiêu?  

=Mod(8/3) 

A. 1     B. 2 

C. 3 D. Báo lỗi  

65. Trong Excel. Biểu thức sau cho kết quả là bao nhiêu?  

=int(8/3) 

A. 1     B. 2  

C. 3 D. Báo lỗi  
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66. Trong Excel. Biểu thức sau cho kết quả là gì ? 

= “abc” + “cde” 

A. Báo lỗi    B. 6  

C.  “abccde” D. “abcde”  

67. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. Khi ta sắp xếp dữ liệu với từ 

khoá Ascending (smallest to largest) thì dữ liệu trong cột sẽ được : 

 A. Sắp xếp tăng dần, thứ tự các giá trị chuỗi trước, số sau.  

 B. Sắp xếp tăng dần, thứ tự các giá trị số trước, chuỗi sau.  

 C. Chỉ sắp xếp tăng dần đối với ô kiểu số (Number). 

 D. Chỉ sắp xếp tăng dần đối với ô kiểu chuỗi (Text). 

68. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. khi ta sắp xếp dữ liệu với từ 

khoá Descending (largest to smallest) thì dữ liệu trong cột sẽ được: 

 A. Sắp xếp giảm dần, thứ tự các giá trị chuỗi trước, số sau.  

 B. Sắp xếp giảm dần, thứ tự các giá trị số trước, chuỗi sau.  

 C. Chỉ sắp xếp giảm dần đối với ô kiểu số (Number). 

 D. Chỉ sắp xếp giảm dần đối với ô kiểu chuỗi (Text). 

69. Trong MS Excel ta có thể sắp xếp thứ tự với kiểu dữ liệu: 

 A. Kiểu Number. B. Kiểu Text 

 C. Kiểu Date/Time D. Không hạn chế kiểu dữ liệu 

70. Hàm có tên là SQRT trong Excel dùng để: 

A. Tính căn bậc hai.  B. Lấy phần dư của phép chia. 

C. Làm tròn số. D. Lấy giá trị tuyệt đối. 

71. Trong MS Excel, hàm có tên là ROUND dùng để: 

A. Lấy phần nguyên của số. B. Lấy phần dư của phép chia   

C. Làm tròn số. D. Câu A, B, C sai. 

72. Trong bảng tính Excel, tại ô A2 có sẵn giá trị số 25 ; Tại ô B2 gõ vào công thức =SQRT(A2) thì 

nhận được kết quả:      

A. 0               B. 5                C. #VALUE!      D. #NAME! 

73. Trong bảng tính Excel, tại ô A2 có sẵn giá trị chuỗi "Tin hoc"; ô B2 có giá trị số 2008. Tại ô C2 gõ 

vào công thức =A2+B2 thì nhận được kết quả:  

A. #VALUE!          B. Tin hoc             C. 2008                D. Tin hoc2008 
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CÂU HỎI TRẮC NGHIỆM ÔN TẬP MS-POWERPOINT 
 

74. Trong MS PowerPoint . Âm thanh đưa vào bài trình diễn  

 A. Thực hiện được chỉ khi tạo hiệu ứng động cho đối tượng trong slide. 

 B. Thực hiện được chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 

 C. Thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

 D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

. 

 

75. Chức năng Animation/ Timing/ Delay trong MS PowerPoint dùng để: 

A.Thiết lập thời gian chờ trước khi slide được trình chiếu 

B.Thiết lập thời gian chờ trước khi hiệu ứng bắt đầu 

C.Thiết lập thời gian hoạt động cho tất cả các hiệu ứng 

D.Tất cả đều đúng 

76. Khi đang làm việc với PowerPoint, muốn thiết lập lại bố cục (trình bày về văn bản, hình ảnh, biểu 

đồ,...) của Slide, ta thực hiện : 

 A. HOME - Slide Layout...     B. VIEW - Slide Layout... 

 C. INSERT - Slide Layout...     D. FILE - Slide Layout... 

77. Trong MS PowerPoint. Đang trình chiếu một bài trình diễn, muốn dừng trình diễn ta nhấn phím 

A. Tab       B. Esc  

C. Home      D. End 

78. Trong MS PowerPoint . Thao tác chọn File -> Open là để  

A. Mở một presentation đã có trên đĩa   

B. Tạo mới một presentation để thiết kế bài trình diễn 

C. Lưu lại presentation đang thiết kế 

D. Lưu lại presentation đang thiết kế với một tên khác 

79. Trong MS PowerPoint, để chèn một slide mới, sử dụng tổ hợp phím 

 A. Ctrl + N    B. Ctrl + L 

 C. Ctrl + M    D. Ctrl + K 

80. MS PowerPoint, thao tác chọn Delete Slide là để 

 A. Xóa slide hiện hành   

 B. Xóa tập tin có nội dung là bài trình diễn hiện hành 

 C. Xóa tất cả các slide trong bài trình diễn đang thiết kế 

 D. Xóa tất cả các đối tượng trong slide hiện hành 

 

81. Trong MS PowerPoint , để thực hiện việc chèn bảng biểu vào slide ta phải 

 A. Chọn Table -> Insert Table   B. Chọn Table -> Insert 

 C. Chọn Insert -> Table    D. Chọn Format -> Table 

82. Trong MS PowerPoint. Thực hiện thao tác liên quan Animation là để 

 A. Tạo hiệu ứng động cho một đối tượng trong slide 

 B. Tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  

 C. Đưa hình ảnh hoặc âm thanh vào bài trình diễn 

 D. Định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 

83. Trong MS PowerPoint Chọn phát biểu sai: 

 A. Khi tạo hiệu ứng động cho một khối văn bản ta có thể cho xuất hiện lần lượt từng từ trong khối 

văn bản khi trình chiếu 

 B. Sau khi đã tạo hiệu ứng động cho một đối tượng nào đó ta không thể thay đổi kiểu hiệu ứng 

cho đối tượng đó 

 C. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide bất kỳ trong bài trình diễn 

 D. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các slide trong bài trình diễn 
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84. Khi đang làm việc với PowerPoint (Office 2013), muốn các thiết kế mẫu có sẵn cho Slide (Theme), 

ta thực hiện từ Ribbon: 

A. HOME - Slide Design - Theme       B. TOOL - Slide Design – Theme 

C. INSERT - Slide Design Theme         D. DESIGN - Theme  

85. Trong MS Powerpoint, loại hiệu ứng nào sau đây dùng để di chuyển đối tượng khi trình chiếu: 

 A. Emphasis B. Exit C. Entrance D. Motion Paths 

86. Muốn ẩn/hiện thanh công cụ trên màn hình soạn thảo PowerPoint, người sử dụng phải 

A. Chọn File ->Exit 

B. Nhấn F1 

C. Nhấn Ctrl+ F1 

D. Không ẩn được 

87. Trong MS PowerPoint, có thể có tối đa bao nhiêu hiệu ứng Animation cho một đối tượng hiển thị: 

A. 1   B. 2   C. 3  D. Rất nhiều  

88. Trong MS PowerPoint, để lưu bài trình chiếu như một tập tin trình chiếu mẫu (Template), ta lưu 

phần mở rộng (kiểu tâp tin) dạng : 

A. POTX   B.PPTX  C. PPTM   D. PPSX 

89. Trong MS PowerPoint, để tạo một slide mẫu trình chiếu cá nhân (Slide Master), ta thực hiện : 

 A. Design/Insert Slide Master   B. Insert/ Slide Master /New 

 C. New/Insert Slide Master   D. View/ Slide Master/ Insert Slide Master 

90. Trong PowerPoint, để thay đổi Theme cho một Slide mà không làm ảnh hưởng đến Slide khác ta 

thực hiện lệnh:   

A. Design/Theme/Click chuột phải trên mẫu Theme/Apply to Matching Slides 

B. Design/Theme/Click chuột phải trên mẫu Theme/Apply to Selected Slides 

C. Design/Theme/Click chuột phải trên mẫu Theme/Apply to All Slides 

D. Không thể thực hiện 

HẾT 

 

 


